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CHAPTER

Getting Started with CMS

This chapter provides these topics about the Cluster Management Suite (CMS) software:

Features, page 3-2

Front Panel View, page 3-4

Topology View, page 3-9

Menus and Toolbar, page 3-14
Interaction Modes, page 3-23

Wizards, page 3-24

Online Help, page 3-25

CMS Window Components, page 3-26
Accessing CMS, page 3-28

Verifying Your Changes, page 3-30
Saving Your Configuration, page 3-30
Restoring Your Configuration, page 3-31
CMS Preferences, page 3-31

Using Different Versions of CMS, page 3-31
Where to Go Next, page 3-32

For system requirements and for browser and Java plug-in configuration procedures, refer to the
release notes.

For procedures for using CMS, refer to the online help.

This chapter describes CMS on the Catalyst 2950 switches. Refer to the appropriate switch
documentation for descriptions of the web-based management software used on other Catalyst switches.
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Features

CMS provides these features (Figure 3-1) for managing switch clusters and individual switches from
Web browsers such as Netscape Communicator or Microsoft Internet Explorer:

e Two views of your network that can be displayed at the same time:

The Front Panel view displays the front-panel image of a specific switch or the front-panel
images of all switches in a cluster. From this view, you can select multiple ports or multiple
switches and configure them with the same settings.

When CMS is launched from a command switch, the Front Panel view displays the front-panel
images of all switches in the cluster. When CMS is launched from a noncommand switch, the
Front Panel view displays only the front panel of the specific switch.

~

Note CMS from a standalone switch or from a noncommand switch is referred to as Device
Manager (also referred to as Switch Manager). Device Manager is for configuring an
individual switch. When you select Device Manager for a specific switch in the cluster,
you launch a separate CMS session. The Device Manager interface can vary between
the Catalyst switch platforms.

The Topology view displays a network map that uses icons that represent switch clusters, cluster
members, cluster candidates, neighboring devices that are not eligible to join a cluster, and link
types. From this view, you can select multiple switches and configure them to run with the same
settings. You can also display link information in the form of link reports and link graphs.

This view is available only when CMS is launched from a command switch.

e Menus and toolbar to access configuration and management options:

The menu bar provides the complete list of options for managing a single switch and switch
clusters.

The toolbar provides buttons for commonly used switch and cluster configuration options and
information windows such as legends and online help.

The port popup menu, in the Front Panel view, provides options specific for configuring and
monitoring switch ports.

The device popup menu, in either the Front Panel or the Topology views, provides switch and
cluster configuration and monitoring options.

The candidate, member, and link popup menus provide options for configuring and monitoring
devices and links in the Topology view.

The toolbar and popup menus provide quick ways to access frequently used menu-bar options.

¢ Tools to simplify configuration tasks:

Interactive modes—guide mode and expert mode—that control the presentation of some
complex configuration options

Wizards that require minimal information from you to configure some complex features

Comprehensive online help that provides high-level concepts and procedures for performing
tasks from the window

Catalyst 2950 Desktop Switch Software Configuration Guide
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e Two levels of access to the configuration options: read-write access for users allowed to change
switch settings; read-only access for users allowed to only view switch settings

e Consistent set of GUI components (such as tabs, buttons, drop-down lists, tables, and so on) for a
uniform approach to viewing and setting configuration parameters

Figure 3-1 CMS Features
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Front Panel View

When CMS is launched from a command switch, the Front Panel view displays the front-panel images
of all switches in the cluster (Figure 3-2). When CMS is launched from a standalone or noncommand
member switch, the Front Panel view displays only the front panel of the specific switch (Figure 3-3).

Figure 3-2  Front Panel View from a Command Switch
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Figure 3-3  Front Panel View from a Standalone Switch
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The cluster tree (Figure 3-2) appears in the left frame of the Front Panel view and shows the name of the
cluster and a list of its members. The sequence of the cluster-tree icons (Figure 3-4) mirror the sequence
of the front-panel images. You can change the sequence by selecting View > Arrange Front Panel. The
colors of the devices in the cluster tree show the status of the devices (Table 3-1).

If you want to configure switch or cluster settings on one or more switches, select the appropriate
front-panel images.

e To select a front-panel image, click either the cluster-tree icon or the corresponding front-panel
image. The front-panel image is then highlighted with a yellow outline.

¢ To select multiple front-panel images, press the Ctrl key, and left-click the cluster-tree icons or the
front-panel images. To deselect an icon or image, press the Ctrl key, and left-click the icon or image.

If the cluster has many switches, you might need to scroll down the window to display the rest of the
front-panel images. Instead of scrolling, you can click an icon in the cluster tree, and CMS then scrolls
and displays the corresponding front-panel image.

Figure 3-4  Cluster-Tree Icons
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Table 3-1 Cluster Tree Icon Colors

Color Device Status

Green |Switch is operating normally.

Yellow |The internal fan of the switch is not operating, or the switch is receiving power from an RPS.

Red Switch is not powered up, has lost power, or the command switch is unable to communicate
with the member switch.

Front-Panel Images

Note

You can manage the switch from a remote station by using the front-panel images. The front-panel
images are updated based on the network polling interval that you set from CMS > Preferences.

This section includes descriptions of the LED images. Similar descriptions of the switch LEDs are
provided in the switch hardware installation guide.

The Preferences window is available if your switch access level is read-only. For more information about
the read-only access mode, see the “Access Modes in CMS” section on page 3-29.
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Figure 3-5 shows the port icons as they appear in the front-panel images. To select a port, click the port

on the front-panel image. The port is then highlighted with a yellow outline. To select multiple ports,
you can:

e Press the left mouse button, drag the pointer over the group of ports that you want to select, and then
release the mouse button.

e Press the Ctrl key, and click the ports that you want to select.

e Right-click a port, and select Select All Ports from the port popup menu.

Figure 3-5 Port Icons
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Table 3-2 describes the colors representing the wavelengths on the CWDM GBIC modules. For port
status LED information, see the “Port Modes and LEDs” section on page 3-7.

Table 3-2 Port Icon Colors for the CWDM GBIC Module Ports

Wavelength Color
1470 nanometers (nm) Gray
1490 nm Violet
1510 nm Blue
1530 nm Green
1550 nm Yellow
1570 nm Orange
1590 nm Red
1610 nm Brown

Redundant Power System LED
The Redundant Power System (RPS) LED shows the RPS status (Table 3-3). Certain switches in the
switch cluster use a specific RPS model:

e Cisco RPS 300 (model PWR300-AC-RPS-N1)—Catalyst 2900 LRE XL, Catalyst 2950,
Catalyst 3524-PWR XL, and Catalyst 3550 switches

e Cisco RPS 600 (model PWR600-AC-RPS)—Catalyst 2900 XL and Catalyst 3500 XL switches,
except the Catalyst 2900 LRE XL and Catalyst 3524-PWR XL switches

Refer to the appropriate switch hardware documentation for RPS descriptions specific for the switch.

Catalyst 2950 Desktop Switch Software Configuration Guide
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Table 3-3 RPS LED

Color RPS Status
Black (off) RPS is off or is not installed.
Green RPS is connected and operational.

Blinking green |RPS is providing power to another switch in the stack.

Amber RPS is connected but not functioning.

The RPS could be in standby mode. To put the RPS in Active mode, press the Standby/Active button on the
RPS, and the LED should turn green. If it does not, one of these conditions could exist:

¢ One of the RPS power supplies could be down. Contact Cisco Systems.
e The RPS fan could have failed. Contact Cisco Systems.

Blinking amber |Internal power supply of the switch is down, and redundancy is lost. The switch is operating on the RPS.

Port Modes and LEDs

The port modes (Table 3-4) determine the type of information displayed through the port LEDs. When
you change port modes, the meanings of the port LED colors (Table 3-5) also change.

S

Note  The bandwidth utilization mode (UTIL LED) does not appear on the front-panel images. Select
Reports > Bandwidth Graphs to display the total bandwidth in use by the switch. Refer to the switch
hardware installation guide for information about using the UTIL LED.

To select or change a mode, click the Mode button until the desired mode LED is green.

Table 3-4 Port Modes

Mode LED  |Description

STAT Link status of the ports. Default mode.

DUPLX Duplex setting on the ports. The default setting on the 10/100 ports is auto. The default setting
on the 10/100/1000 ports is full.

SPEED Speed setting on the ports. The default setting on the 10/100 and 10/100/1000 ports is auto.

Catalyst 2950 Desktop Switch Software Configuration Guide
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Table 3-5 Port LEDs

Port Mode Port LED Color  |Description
STAT Cyan (off) No link.

Green Link present.

Amber Link fault. Error frames can affect connectivity, and errors such as excessive
collisions, CRC errors, and alignment and jabber errors are monitored for a link-fault
indication.

Port is not forwarding. Port was disabled by management, by an address violation,
or by Spanning Tree Protocol (STP).
Note  After a port is reconfigured, the port LED can remain amber for up to
30 seconds as STP checks the switch for possible loops.
Brown No link and port is administratively shut down.
DUPLX Cyan (off) Port is operating in half-duplex mode.

Green Port is operating in full-duplex mode.

SPEED Cyan (off) Port is operating at 10 Mbps (10/100 ports) or no link (10/100/1000 ports and GBIC
module ports).

Green Port is operating at 100 Mbps (10/100 ports) or 1000 Mbps (GBIC module ports).

Blinking green  |Port is operating at 1000 Mbps (10/100/1000 ports).

VLAN Membership Modes

~

Note

Ports in the Front Panel view are outlined by colors (Table 3-6) when you click Highlight VLAN Port
Membership Modes on the Configure VLANS tab on the VLAN window

(VLAN > VLAN > Configure VLANS). The colors show the VLAN membership mode of each port.
The VLAN membership mode determines the kind of traffic the port carries and the number of VLANSs
it can belong to. For more information about these modes, see the “VLAN Port Membership Modes”
section on page 13-3.

This feature is not supported on the Catalyst 1900 and Catalyst 2820 switches.

Table 3-6 VLAN Membership Modes

Mode Color
Static access Light green
Dynamic access Pink
802.1Q trunk Peach
Negotiate trunk White

i Catalyst 2950 Desktop Switch Software Configuration Guide
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Topology View

Note

The Topology view displays how the devices within a switch cluster are connected and how the switch
cluster is connected to other clusters and devices. From this view, you can add and remove cluster
members. This view provides two levels of detail of the network topology:

e When you right-click a cluster icon and select Expand Cluster, the Topology view displays the
switch cluster in detail. This view shows the command switch and member switches in a cluster. It
also shows candidate switches that can join the cluster. This view does not display the details of any
neighboring switch clusters (Figure 3-6).

e  When you right-click a command-switch icon and select Collapse Cluster, the cluster is collapsed
and represented by a single icon. The view shows how the cluster is connected to other clusters,
candidate switches, and devices that are not eligible to join the cluster (such as routers, access
points, IP phones, and so on) (Figure 3-7).

The Topology view displays only the switch cluster and network neighborhood of the specific command
or member switch that you access. To display a different switch cluster, you need to access the command
switch or member switch of that cluster.

You can arrange the device icons in this view. To move a device icon, click and drag the icon. To select
multiple device icons, you can either:

e Press the left mouse button, drag the pointer over the group of device icons that you want to select,
and then release the mouse button.

e Press the Ctrl key, and click the device icons that you want to select.

After selecting the icons, drag the icons to any area in the view.
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Figure 3-6 Expand Cluster View
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Figure 3-7 Collapse Cluster View
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Topology Icons

The Topology view and the cluster tree use the same set of device icons to represent clusters, command
and standby command switches, and member switches (Figure 3-8). The Topology view also uses
additional icons to represent these types of neighboring devices:

e Customer premises equipment (CPE) devices that are connected to Long-Reach Ethernet (LRE)
switches

¢ Devices that are not eligible to join the cluster, such as Cisco IP phones, Cisco access points, and
Cisco Discovery Protocol (CDP)-capable hubs and routers

,
Note The System Switch Processor (SSP) card in the Cisco Integrated Communications System
(ICS) 7750 appears as a Layer 2 switch. SSP cards are not eligible to join switch clusters.

e Devices that are identified as unknown devices, such as some Cisco devices and third-party devices

ﬁ Neighboring devices are only displayed if they are connected to cluster members. To display neighboring

devices in the Topology view, either add the switch to which they are connected to a cluster, or enable
that switch as a command switch.

~

Note Candidate switches are distinguished by the color of their device label. Device labels and their colors are
described in the “Colors in the Topology View” section on page 3-12.

To select a device, click the icon. The icon is then highlighted. To select multiple devices, you can either:

e Press the left mouse button, drag the pointer over the group of icons that you want to select, and then
release the mouse button.

e Press the Ctrl key, and click the icons that you want to select.

Figure 3-8 Topology-View Device Icons
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The Topology view also uses a set of link icons (Figure 3-9) to show the link type and status between
two devices. To select a link, click the link that you want to select. To select multiple links, press the Ctrl
key, and click the links that you want to select.

Catalyst 2950 Desktop Switch Software Configuration Guide
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Figure 3-9 Topology-View Link Icons
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Device and Link Labels

The Topology view displays device and link information by using these labels:

Cluster and switch names

Switch MAC and IP addresses

Link type between the devices

Link speed and IDs of the interfaces on both ends of the link

When using these labels, keep these considerations in mind:

The IP address displays only in the labels for the command switch and member switches.

The label of a neighboring cluster icon only displays the IP address of the command-switch IP
address.

The displayed link speeds are the actual link speeds except on the LRE links, which display the
administratively assigned speed settings.

You can change the label settings from the Topology Options window, which is displayed by selecting
View > Topology Options.

Colors in the Topology View

The colors of the Topology view icons show the status of the devices and links (Table 3-7, Table 3-8, and
Table 3-9).
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Table 3-7 Device Icon Colors

Icon Color |Color Meaning

Green The device is operating.

Yellow! The internal fan of the switch is not operating, or the switch is receiving power from an
RPS.

Red! The device is not operating.

1. Available only on the cluster members.

Table 3-8 Single Link Icon Colors

Link Color |Color Meaning
Green Active link
Red Down or blocked link

Table 3-9 Multiple Link Icon Colors

Link Color

Color Meaning

Both green

All links are active.

One green; one red |At least one link is active, and at least one other link is down

or blocked.

Both red

All links are down or blocked.

The color of a device label shows the cluster membership of the device (Table 3-10).

Table 3-10 Device Label Colors

Label

Color Color Meaning

Green A cluster member, either a member switch or the command switch
Cyan A candidate switch that is eligible to join the cluster

Yellow An unknown device or a device that is not eligible to join the cluster

Topology Display Options

You can set the type of information displayed in the Topology view by changing the settings in the
Topology Options window. To display this window, select View > Topology Options. From this
window, you can select:

e Device icons that you want displayed in or filtered from the Topology View window

¢ Interface IDs and Actual Speed values that you want displayed in the Link window

e Host Names, IP addresses, and MAC address labels that you want displayed in the Node window

[ 78-11380-05
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Menus and Toolbar

The configuration and monitoring options for configuring switches and switch clusters are available
from menus and a toolbar.

Menu Bar

The menu bar provides the complete list of options for managing a single switch and switch cluster.

Options displayed from the menu bar can vary:

Note  The menu-bar options on a Catalyst 2950 switch change depending on whether the switch is running the
enhanced software image (EI) or the standard image (SI). The footnotes in Table 3-11 list the options
available if the switch is running the EI.

¢ Access modes affect the availability of features from CMS. The footnotes in Table 3-11 describe the
availability of an option based on your access mode in CMS: read-only (access level 1-14) and
read-write (access level 15). For more information about how access modes affect CMS, see the
“Access Modes in CMS” section on page 3-29.

e The option for enabling a command switch is only available from a CMS session launched from a
command-capable switch.

¢ Cluster management tasks, such as upgrading the software of groups of switches, are available only
from a CMS session launched from a command switch.

e If you launch CMS from a specific switch, the menu bar displays the features supported only by that
switch.

e If you launch CMS from a command switch, the menu bar displays the features supported on the
switches in the cluster, with these exceptions:

— If the command switch is a Layer 3 switch, such as a Catalyst 3550 switch, the menu bar
displays the features of all Layer 3 and Layer 2 switches in the cluster.

— Ifthe command switch is a Layer 2 switch, such as a Catalyst 2950 or Catalyst 3500 XL switch,
the menu bar displays the features of all Layer 2 switches in the cluster. The menu bar does not
display Layer 3 features even if the cluster has Catalyst 3550 Layer 3 member switches.

Catalyst 2950 Desktop Switch Software Configuration Guide
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Menus and Toolbar

e We strongly recommend that the highest-end, command-capable switch in the cluster be the
command switch:

— If your switch cluster has a Catalyst 3550 switch, that switch should be the command switch.

— Ifyour switch cluster has Catalyst 2900 XL, Catalyst 2950, and Catalyst 3500 XL switches, the
Catalyst 2950 should be the command switch.

— If your switch cluster has Catalyst 1900, Catalyst 2820, Catalyst 2900 XL, and
Catalyst 3500 XL switches, either the Catalyst 2900 XL or Catalyst 3500 XL should be the
command switch.

e Standby command switches must meet these requirements:

— When the command switch is a Catalyst 3550 switch, all standby command switches must be
Catalyst 3550 switches.

— When the command switch is a Catalyst 2950 switch running Release 12.1(9)EA1 or later, all
standby command switches must be Catalyst 2950 switches running Release 12.1(9)EA1 or
later.

— When the command switch is a Catalyst 2950 switch running Release 12.1(6)EA2 or later, all
standby command switches must be Catalyst 2950 switches running Release 12.1(6)EA2 or
later.

— When the command switch is running Release 12.0(5)WC?2 or earlier, the standby command
switches can be these switches: Catalyst 2900 XL, Catalyst 2950, and Catalyst 3500 XL
switches.

We strongly recommend that the command switch and standby command switches are of the same
switch platform and that both are running the same level of software (SI or EI). In the event of a
failover, the standby command switch must support the same configuration and services that are
running on the command switch.

— If you have a Catalyst 3550 command switch, the standby command switches should be
Catalyst 3550 switches.

— If you have a Catalyst 2950 command switch, the standby command switches should be
Catalyst 2950 switches.

- If you have a Catalyst 2900 XL or Catalyst 3500 XL command switch, the standby command
switches should be Catalyst 2900 XL and Catalyst 3500 XL switches.

Refer to the release notes for the Catalyst switches that can be part of a switch cluster.

Unless noted otherwise, Table 3-11 lists the menu-bar options available from a Catalyst 2950 command
switch when the cluster contains only Catalyst 2950 member switches. The menu bar of the command
switch displays all menu-bar options available from the cluster, including options from member switches
from other cluster-capable switch platforms.
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Table 3-11 Menu Bar

Menu-Bar Options

Task

CMS

Page Setup

Set default document printer properties to be used when printing from CMS.

Print Preview

View the way the CMS window or help file will appear when printed.

Print

Print a CMS window or help file.

Guide Mode/Expert Mode'

Select which interaction mode to use when you select a configuration option.

Preferences?

Set CMS display properties, such as polling intervals, the default views to open at startup,
and the color of administratively shutdown ports.

Administration

IP Addresses?

Configure IP information for a switch.

SNMP?

Enable and disable Simple Network Management Protocol (SNMP), enter community
strings, and configure end stations as trap managers.

System Time?

Configure the system time or configure the Network Time Protocol (NTP).

HTTP Port?

Configure the Hypertext Transfer Protocol (HTTP) port number.

Users and Passwords

Configure usernames and passwords for privilege levels 0 to 15.

Console Baud Rate?

Change the baud rate for the switch console port.

MAC Addresses®

Enter dynamic, secure, and static addresses in a switch address table. You can also define
the forwarding behavior of static addresses.

ARP?

Display the device Address Resolution Protocol (ARP) table, and configure the ARP
cache timeout setting.

Save Configuration'

Save the configuration for the cluster or switch to Flash memory.

Restore Configuration

Restore the configuration file to one or more switches in the cluster.

Software Upgrade!

Upgrade the software for the cluster or a switch.

System Reload'

Reboot the switch with the latest installed software.

Event Notification

Create notification IDs that generate e-mail notifications when system events occur.

Cluster

Cluster Manager®

Launch a CMS session from the member switch.

Create Cluster!'

Designate a command switch, and name a cluster.

Delete Cluster' >

Delete a cluster.

Add to Cluster!?

Add a candidate to a cluster.

Remove from Cluster' 3

Remove a member from the cluster.

Standby Command Switches? >

Create a Hot Standby Router Protocol (HSRP) standby group to provide
command-switch redundancy.

Hop Count? ®

Enter the number of hops away that a command switch looks for members and for
candidate switches.

Device

Device Manager®

Launch Device Manager for a specific switch.

Host Name!

Change the host name of a switch.

STP?

Display and configure STP parameters for a switch.
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Menus and Toolbar

Menu-Bar Options

Task

IGMP Snooping?

Enable and disable Internet Group Management Protocol (IGMP) snooping and IGMP
Immediate-Leave processing on the switch. Join or leave multicast groups, and configure
multicast routers.

802.1X! Configure 802.1X authentication of devices as they are attached to LAN ports in a
g y p
point-to-point infrastructure.
ACL?® Create and maintain access control lists (ACLs), and attach ACLs to specific ports.

(guide mode available!)

Security Wizard' ¢

Filter certain traffic, such as HTTP traffic, to certain networks or devices. Restrict access
to servers, networks, or application data from certain networks or devices.

QoSs?
(guide mode available on some
options')

Display submenu options to enable and disable quality of service (QoS) and to configure
or modify these parameters:

e Trust settings?
e Queues’
. Maps2 6
e Classes? 6(guide mode available)

¢ Policies? 6(guide mode available')

AVVID Wizards'

e Voice Wizard!—Configure a port to send or receive voice traffic.°

e Video Wizard'—Optimize multiple video servers for sending video traffic.®

e Data Wizard'—Provide a higher priority to specific applications.®

Port

Port Settings>

Display and configure port parameters on a switch.

Port Search

Search for a port through its description.

Port Security!

Enable port security on a port.

EtherChannels?

Group ports into logical units for high-speed links between switches.

SPAN?

Enable Switched Port Analyzer (SPAN) port monitoring.

Protected Port?

Configure a port to prevent it from receiving bridged traffic from another port on the
same switch.

Flooding Control?

Block the normal flooding of unicast and multicast packets, and enable the switch to
block packet storms.

VLAN

VLAN?
(guide mode available)

Display VLAN membership, assign ports to VLANS, and configure 802.1Q trunks.
Display and configure the VLAN Trunking Protocol (VTP) for interswitch VLAN
membership.

Management VLAN?

Change the management VLAN on the switch.

VMPS?

Configure the VLAN Membership Policy Server (VMPS).

Voice VLAN?

Configure a port to use a voice VLAN for voice traffic, separating it from the VLANS for
data traffic.

Reports
Inventory Display the device type, software version, IP address, and other switch information.
Catalyst 2950 Desktop Switch Software Configuration Guide
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Table 3-11 Menu Bar (continued)

Menu-Bar Options

Task

Port Statistics

Display port statistics.

Bandwidth Graphs

Display graphs that plot the total bandwidth in use by the switch.

Link Graphs

Display a graph showing the bandwidth being used for the selected link.

Link Reports

Display the link report for two connected devices. If one device is an unknown device or
a candidate, only the cluster-member side of the link displays.

Resource Monitor®

Display masks for ACL and QoS policy maps.

System Messages

Display the most recent system messages (IOS messages and switch-specific messages)
sent by the switch software.

This option is available on the Catalyst 2950 or 3550 switches. It is not available from
the Catalyst 2900 XL and Catalyst 3500 XL switches. You can display the system
messages of the Catalyst 2900 XL and 3500 XL switches when they are in a cluster
where the command switch is a Catalyst 2950 switch running Release 12.1(6)EA2 or
later or a Catalyst 3550 switch running Release 12.1(8)EAT1 or later. For more
information about system messages, refer to the switch system message guide.

View

Refresh

Update the views with the latest status.

Front Panel

Display the Front Panel view.

Arrange Front Panel' >

Rearrange the order in which switches appear in the Front Panel view.

Topology?

Display the Topology view.

Topology Options >

Select the information to be displayed in the Topology view.

Automatic Topology Layout®

Request CMS to rearrange the topology layout.

Save Topology Layout! >

Save the presentation of the cluster icons that you arranged in the Topology view to Flash
memory.

Window List the open windows in your CMS session.
Help
Overview Obtain an overview of the CMS interface.
What’s New Obtain a description of the new CMS features.

Help For Active Window

Display the help for the active open window. This is the same as clicking Help from the
active window.

Contents List all of the available online help topics.
Legend Display the legend that describes the icons, labels, and links.
About Display the CMS version number.

S

i Catalyst 2950 Desktop Switch Software Configuration Guide

Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access Modes in CMS” section on

page 3-29.

Some options from this menu option are not available in read-only mode.

Available only from a Device Manager session on a cluster member.

Available only from a Device Manager session on a command-capable switch that is not a cluster member.

Available only from a cluster management session.

Available only from a switch running the EI.
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Toolbar

The toolbar buttons display commonly-used switch and cluster configuration options and information
windows such as legends and online help. Hover the cursor over an icon to display the feature. Table 3-12
describes the toolbar options, from left to right on the toolbar.

Table 3-12 Toolbar Buttons

Keyboard

Toolbar Option Shortcut | Task

Print Ctrl-P Print a CMS window or help file.

Preferences! Ctrl-R Set CMS display properties, such as polling intervals, the views to open at CMS
startup, and the color of administratively shutdown ports.

Save Configuration? Ctrl-S Save the configuration for the cluster or switch to Flash memory.

Software Upgrade? Ctrl-U Upgrade the software for the cluster or a switch.

Port Settings' - Display and configure port parameters on a switch.

VLAN! - Display VLAN membership, assign ports to VLANS, and configure 802.1Q
trunks.

Inventory - Display the device type, the software version, the IP address, and other
information about a switch.

Refresh - Update the views with the latest status.

Front Panel - Display the Front Panel view.

Topology? - Display the Topology view.

Topology Options® - Select the information to be displayed in the Topology view.

Save Topology Layout*® |- Save the presentation of the cluster icons that you arranged in the Topology view
to Flash memory.

Legend - Display the legend that describes the icons, labels, and links.

Help For Active Window |F1 key Display the help for the active open window. This is the same as clicking Help
from the active window.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access Modes in CMS” section

on page 3-29.

2. Some options from this menu option are not available in read-only mode.

3. Available only from a cluster-management session.

[ 78-11380-05
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Front Panel View Popup Menus

These popup menus are available in the Front Panel view.

Device Popup Menu

You can display all switch and cluster configuration windows from the menu bar, or you can display
commonly used configuration windows from the device popup menu (Table 3-13). To display the device
popup menu, click the switch icon from the cluster tree or the front-panel image itself, and right-click.

Table 3-13 Device Popup Menu

Popup Menu Option Task

Device Manager! Launch Device Manager for the switch.

Host Name? Change the name of the switch.

Delete Cluster® > * Delete a cluster.

Remove from Cluster? * Remove a member from the cluster.

Bandwidth Graphs Display graphs that plot the total bandwidth in use.

Properties Display information about the device and port on either end of the link and
the state of the link.

Available from a cluster member switch but not from the command switch.

2. Not available in read-only mode. For more information about the read-only mode, see the “Access Modes in CMS” section
on page 3-29.

3. Available only from the command switch.

4. Available only from a cluster-management session.

Port Popup Menu

You can display all port configuration windows from the Port menu on the menu bar, or you can display
commonly used port configuration windows from the port popup menu (Table 3-14). To display the port
popup menu, click a specific port image, and right-click.

Table 3-14 Port Popup Menu

Popup Menu Option |Task

Port Settings' Display and configure port settings.

VLAN! Define the VLAN mode for a port or ports and add ports to VLANSs. Not
available for the Catalyst 1900 and Catalyst 2820 switches.

Port Security' ? Enable port security on a port.

Link Graphs® Display a graph showing the bandwidth used by the selected link.

Select All Ports Select all ports on the switch for global configuration.

1. Some options from this menu option are not available in read-only mode.

2. Available on switches that support the Port Security feature.

3. Available only when there is an active link on the port (that is, the port LED is green when in port status mode).

Catalyst 2950 Desktop Switch Software Configuration Guide
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Topology View Popup Menus

These popup menus are available in the Topology view.

Link Popup Menu

You can display reports and graphs for a specific link displayed in the Topology view (Table 3-15). To
display the link popup menu, click the link icon, and right-click.

Table 3-15 Link Popup Menu

Popup Menu Option | Task

Link Report Display the link report for two connected devices. If one device is an unknown
device or a candidate, only the cluster member side of the link displays.

Link Graph Display a graph showing the current bandwidth used by the selected link. You
can change the graph polling interval by selecting CMS > Preferences.

Properties Display information about the device and port on either end of the link and the
state of the link.

The Link Report and Link Graph options are not available if at both ends of the link are
¢ Candidate switches
e (Catalyst 1900 and Catalyst 2820 switches
e Devices that are not eligible to join the cluster

If multiple links are configured between two devices, when you click the link icon and right-click, the
Multilink Content window appears (Figure 3-10). Click the link icon in this window, and right-click to
display the link popup menu specific for that link.

Figure 3-10 Multilink Decomposer Window
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Device Popup Menus

Specific devices in the Topology view display a specific popup menu:
e Cluster (Table 3-16)

e Command switch (Table 3-17)

e Member or standby command switch (Table 3-18)

e Candidate switch with an IP address (Table 3-19)

e (Candidate switch without an IP address (Table 3-20)

e Neighboring devices (Table 3-21)

Note = The Device Manager option in these popup menus is available in read-only mode on Catalyst 2900 XL
and Catalyst 3500 XL switches running Release 12.0(5)WC2 and later. It is also available on
Catalyst 2950 switches running Release 12.1(6)EA2 and later and on Catalyst 3550 switch running
Release 12.1(8)EA1 or later. It is not available on the Catalyst 1900 and Catalyst 2820 switches.

To display a device popup menu, click an icon, and right-click.

Table 3-16 Device Popup Menu of a Cluster Icon

Popup Menu Option  |Task

Expand cluster View a cluster-specific topology view.

Properties Display information about the device.

Table 3-17 Device Popup Menu of a Command-Switch Icon

Popup Menu Option | Task

Collapse cluster View the neighborhood outside a specific cluster.

Host Name' Change the host name of a switch.

Bandwidth Graphs Display graphs that plot the total bandwidth in use by the switch.

Properties Display information about the device.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access
Modes in CMS” section on page 3-29.

Table 3-18 Device Popup Menu of a Member or Standby Command-Switch Icon

Popup Menu Option Task

Remove from Cluster! Remove a member from the cluster.

Host Name' Change the host name of a switch.

Device Manager? Launch Device Manager for a switch.

Bandwidth Graphs Display graphs that plot the total bandwidth in use by the switch.
Properties Display information about the device.

1. Available only from a cluster-management session.

2. Available from a cluster member switch but not from the command switch.
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Table 3-19 Device Popup Menu of a Candidate-Switch Icon (When the Candidate Switch Has an

IP Address)

Popup Menu Option

Task

Add to Cluster!

Add a candidate to a cluster.

Device Manager”

Launch Device Manager for a switch.

Properties

Display information about the device.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access
Modes in CMS” section on page 3-29.

2. Available from a cluster member switch but not from the command switch.

Table 3-20 Device Popup Menu of a Candidate-Switch Icon (When the Candidate Switch Does Not
Have an IP Address)

Popup Menu Option

Task

Add to Cluster!

Add a candidate to a cluster.

Properties

Display information about the device.

1. Not available in read-only mode. For more information about the read-only and read-write access modes, see the “Access
Modes in CMS” section on page 3-29.

Table 3-21 Device Popup Menu of a Neighboring-Device Icon

Popup Menu Option

Task

Device Manager!

Access the web management interface of the device.

Note This option is available on Cisco access points, but not on Cisco IP
phones, hubs, routers and on unknown devices such as some Cisco
devices and third-party devices.

Disqualification Code

Display the reason why the device could not join the cluster.

Properties

Display information about the device.

1. Available from a cluster member switch but not from the command switch.

Interaction Modes

You can change the interaction mode of CMS to either guide or expert mode. Guide mode steps you
through each feature option and provides information about the parameter. Expert mode displays a
configuration window in which you configure the feature options.

[ 78-11380-05
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W Wizards

Guide Mode
~

Note

Expert Mode

Wizards
~

Note

Guide mode is not available if your switch access level is read-only. For more information about the
read-only access mode, see the “Access Modes in CMS” section on page 3-29.

Guide mode is for users who want a step-by-step approach for completing a specific configuration task.
This mode is not available for all features. A menu-bar option that has a person icon means that guide
mode is available for that option.

When you click Guide Mode and then select a menu-bar option that supports guide mode, CMS displays
a specific parameter of the feature with information about the parameter field. To configure the feature,
you provide the information that CMS requests in each step until you click Finish in the last step.
Clicking Cancel at any time closes and ends the configuration task without applying any changes.

If Expert Mode is selected and you want to use guide mode, you must click Guide Mode before
selecting an option from the menu bar, tool bar, or popup menu. If you change the interaction mode after
selecting a configuration option, the mode change does not take effect until you select another
configuration option.

Expert mode is for users who prefer to display all the parameter fields of a feature in a single CMS
window. Information about the parameter fields is available by clicking the Help button.

Wizards are not available if your switch access level is read-only. For more information about the
read-only access mode, see the “Access Modes in CMS” section on page 3-29.

Wizards simplify some configuration tasks on the switch. Similar to the guide mode, wizards provide a
step-by-step approach for completing a specific configuration task. Unlike guide mode, a wizard does
not prompt you to provide information for all of the feature options. Instead, it prompts you to provide
minimal information and then uses the default settings of the remaining options to set up default
configurations.

Wizards are not available for all features. A menu-bar option that has wizard means that selecting that
option launches the wizard for that feature.
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Tool Tips

CMS displays a popup message when you move your mouse over these devices:

e A yellow device icon in the cluster tree or in Topology view—A popup displays a fault message,
such as that the RPS is faulty or that the switch is unavailable because you are in read-only mode.

e A red device icon in the cluster tree or in Topology view—A popup displays a message that the
switch is down.

If you move your mouse over a table column heading, a popup displays the full heading.

Online Help

CMS provides comprehensive online help to assist you in understanding and performing configuration
and monitoring tasks from the CMS windows (Figure 3-11).

¢ Feature help, available from the menu bar by selecting Help > Contents, provides background
information and concepts on the features.

e Dialog-specific help, available from Help on the CMS windows, provides procedures for
performing tasks.

¢ Index of help topics.
¢ Glossary of terms used in the online help.

You can send us feedback about the information provided in the online help. Click Feedback to display
an online form. After completing the form, click Submit to send your comments to Cisco. We appreciate
and value your comments.

Figure 3-11 Help Contents and Index
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CMS Window Components

CMS windows consistently present configuration information. Figure 3-12 shows the components of a

typical CMS window.

Figure 3-12 CMS Window Components
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— OK saves your changes and
closes the window.

— Modify displays a secondary
window from which you can
change settings.

and left-click rows to select non-
contiguous rows.

Click a tab to display more
information.

Host Name List

—— Click a row to select it. Press Shift,
and left-click another row to select
contiguous multiple rows. Press Cirl,

T

Apply saves your changes and leaves J
the window open.

Refresh refreshes the window to display
the latest information.

Cancel closes the window without saving
the changes.

Help displays help for the window and the ———
menu of Help topics.

Select a cluster member from the
Host Name list to display its settings.

To display or change the configuration of a cluster member, you need to select the specific switch from

the Host Name drop-down list. The list

appears in the configuration window of each feature and lists

only the cluster members that support that feature. For example, the Host Name list on the VLAN

i Catalyst 2950 Desktop Switch Software Configuration Guide
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window does not include Catalyst 1900 and Catalyst 2820 switches even though they are part of the
cluster. Similarly, the Host Name list on the LRE Profiles window only lists the LRE switches in the
cluster.

Tabs, Lists, and Tables

Some CMS windows have tabs that present different sets of information. Tabs are arranged like folder
headings across the top of the window. Click the tab to display its information.

Listed information can often be changed by selecting an item from a list. To change the information,
select one or more items, and click Modify. Changing multiple items is limited to those items that apply
to at least one of the selections.

Some CMS windows present information in a table format. You can edit the information in these tables.

Note  You can resize the width of the columns to display the column headings, or you can hover your cursor
over the heading to display a popup description of the column.

Icons Used in Windows

Some window have icons for sorting information in tables, for showing which cells in a table are
editable, and for displaying further information from Cisco.com (Figure 3-13).

Figure 3-13 Window Icons
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Buttons

These are the most common buttons that you use to change the information in a CMS window:

e OK—Save any changes and close the window. If you made no changes, the window closes. If CMS
detects errors in your entry, the window remains open. For more information about error detection,
see the “Error Checking” section on page 3-30.

e Apply—Save any changes made in the window and leave the window open. If you made no changes,
the Apply button is disabled.

¢ Refresh—Update the CMS window with the latest status of the device. Unsaved changes are lost.
e (Cancel—Do not save any changes made in the window and close the window.
e Help—Display procedures on performing tasks from the window.

¢ Modify—Display the secondary window for changing information on the selected item or items.
You usually select an item from a list or table and click Modify.
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Accessing CMS

A

This section assumes the following:

¢ You know the IP address and password of the command switch or a specific switch. This information
is either:

— Assigned to the switch by following the setup program, as described in the release notes.

— Changed on the switch by following the information in the “Assigning Switch Information”
section on page 4-2 and “Preventing Unauthorized Access to Your Switch” section on page 7-1.
Considerations for assigning IP addresses and passwords to a command switch and cluster
members are described in the “IP Addresses” section on page 6-16 and the “Passwords” section
on page 6-17.

* You know your access privilege level to the switch.

* You have referred to the release notes for system requirements and have followed the procedures for
installing the required Java plug-ins and configuring your browser.

Caution

Note

Step 1

Step 2

Step 3

Copies of the CMS pages you display are saved in your browser memory cache until you exit the browser
session. A password is not required to redisplay these pages, including the Cisco Systems Access page.
You can access the CLI by clicking Monitor the router - HTML access to the command line interface
from a cached copy of the Cisco Systems Access page. To prevent unauthorized access to CMS and the
CLI, exit your browser to end the browser session.

If you have configured the Terminal Access Controller Access Control System Plus (TACACS+) or
Remote Authentication Dial-In User Service (RADIUS) feature on the switch, you can still access the
switch through CMS. For information about how inconsistent authentication configurations in switch
clusters can affect access through CMS, see the “TACACS+ and RADIUS” section on page 6-18.

To access CMS, follow these steps:

Enter the switch IP address and your privilege level in the browser Location field (Netscape
Communicator) or Address field (Microsoft Internet Explorer). For example:

http://10.1.126.45:184/1evel/14/

where 10.1.126.45 is the switch IP address, 184 is the HTTP port, and 1evel/14 is the privilege level.
You do not need to enter the HTTP port if the switch is using HTTP port 80 (the default) or enter the
privilege level if you have read-write access to the switch (privilege level is 15). For information about
the HTTP port, see the “HTTP Access to CMS” section on page 3-29. For information about privilege
levels, see the “Access Modes in CMS” section on page 3-29.

When prompted for a username and password, enter only the switch enable password. CMS prompts you
a second time for a username and password. Enter only the enable password again.

If you configure a local username and password, make sure you enable it by using the ip http
authentication global configuration command. Enter your username and password when prompted.

Click Web Console.

If you access CMS from a standalone or member switch, Device Manager appears. If you access CMS
from a command switch, you can display the Front Panel and Topology views.
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Access Modes in CMS

~

Note

CMS provides two levels of access to the configuration options: read-write access and read-only access.
Privilege levels 0 to 15 are supported.

e Privilege level 15 provides you with read-write access to CMS.

e Privilege levels 1 to 14 provide you with read-only access to CMS. Any options in the CMS
windows, menu bar, toolbar, and popup menus that change the switch or cluster configuration are
not shown in read-only mode.

e Privilege level 0 denies access to CMS.

If you do not include a privilege level when you access CMS, the switch verifies if you have
privilege-level 15. If you do not, you are denied access to CMS. If you do have privilege-level 15, you
are granted read-write access. Therefore, you do not need to include the privilege level if it is 15.
Entering zero denies access to CMS. For more information about privilege levels, see the “Preventing
Unauthorized Access to Your Switch” section on page 7-1.

e If your cluster has these member switches running earlier software releases and if you have
read-only access to these member switches, some configuration windows for those switches display
incomplete information:

— Catalyst 2900 XL or Catalyst 3500 XL member switches running Release 12.0(5)WC2 or
earlier

— Catalyst 2950 member switches running Release 12.0(5)WC2 or earlier
— Catalyst 3550 member switches running Release 12.1(6)EA1 or earlier
For more information about this limitation, refer to the release notes.
e These switches do not support read-only mode on CMS:
— Catalyst 1900 and Catalyst 2820
— Catalyst 2900 XL switches with 4-MB CPU DRAM

In read-only mode, these switches appear as unavailable devices and cannot be configured from
CMS.

HTTP Access to CMS

CMS uses Hypertext Transfer Protocol (HTTP), which is an in-band form of communication with the
switch through any one of its Ethernet ports and that allows switch management from a standard web
browser. The default HTTP port is 80.

If you change the HTTP port, you must include the new port number when you enter the IP address in
the browser Location or Address field (for example, http://10.1.126.45:184 where 184 is the new HTTP
port number).

Do not disable or otherwise misconfigure the port through which your management station is
communicating with the switch. You might want to write down the port number to which you are
connected. Changes to the switch IP information should be done with care.

For information about connecting to a switch port, refer to the switch hardware installation guide.
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Verifying Your Changes

CMS provides notification cues to help you track and confirm the changes you make.

Change Notification

A green border around a field or table cell means that you made an unsaved change to the field or table
cell. Previous information in that field or table cell is displayed in the window status bar. When you save
the changes or if you cancel the change, the green border disappears.

Error Checking

A red border around a field means that you entered invalid data in the field. An error message also
displays in the window status bar. When you enter valid data in the field, a green border replaces the red
border until you either save or cancel the change.

If there is an error in communicating with the switch or if you make an error while performing an action,
a message notifies you about the error.

Saving Your Configuration

~

Note

L

Tip

Note

The Save Configuration option is not available if your switch access level is read-only. For more
information about the read-only access mode, see the “Access Modes in CMS” section on page 3-29.

As you make cluster configuration changes (except for changes to the Topology view and in the
Preferences window), make sure that you periodically save the configuration from the command switch.
The configuration is saved on the command and member switches.

The front-panel images and CMS windows always display the running configuration of the switch.
When you make a configuration change to a switch or switch cluster, the change becomes part of the
running configuration. The change does not automatically become part of the configuration file, which
is the startup configuration used each time the switch restarts. If you do not save your changes, they are
lost when the switch restarts.

Catalyst 1900 and Catalyst 2820 switches automatically save configuration changes to Flash memory as
they occur.

For CMS procedures for saving your switch configuration, refer to the online help.
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Restoring Your Configuration

After you save a switch configuration, you can restore the configuration to one or more switches for these
reasons:

¢ You made an incorrect change to the current running configuration and want to reload a saved
configuration.

* You need to reload a switch after a switch failure or power failure.
¢ You want to copy the configuration of a switch to other switches.

For CMS procedures for restoring a switch configuration, refer to the online help.

CMS Preferences

When you exit from CMS, your CMS preferences are saved to your PC in a file called .cms_properties.
You can copy this file to other PCs. The file is stored in a default configuration directory, such as
C:\Documents and Settings\username. If you cannot locate the CMS preferences file, select

Start > Search > For Files or Folders..., and search for .cms_properties.

S

Note  In previous CMS versions, the preferences were saved in Flash memory when you exited from CMS.

Using Different Versions of CMS

When managing switch clusters through CMS, remember that clusters can have a mix of switch models
using different IOS releases and that CMS in earlier IOS releases and on different switch platforms might
look and function differently from CMS in this IOS release.

When you select Device > Device Manager for a cluster member, a new browser session is launched,
and the CMS version for that switch is displayed.

Here are examples of how CMS can differ between IOS releases and switch platforms:

e On Catalyst switches running Release 12.0(5)WC2 or earlier or Release 12.1(6)EA1 or earlier, the
CMS versions in those software releases might appear similar but are not the same as this release.
For example, the Topology view in this release is not the same as the Topology view or Cluster View
in those earlier software releases.

e CMS on the Catalyst 1900 and Catalyst 2820 switches is referred to as Switch Manager. Cluster
management options are not available on these switches. This is the earliest version of CMS.

Refer to the documentation specific to the switch and its IOS release for descriptions of the CMS version
you are using.
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Where to Go Next

Before configuring the switch, refer to these places for start-up information:
e Switch release notes on Cisco.com:
— CMS software requirements
— Procedures for running the setup program
— Procedures for browser configuration
— Procedures for accessing CMS
e Chapter 4, “Assigning the Switch IP Address and Default Gateway”
e Chapter 7, “Administering the Switch”

The rest of this guide provides information about and CLI procedures for the software features supported
in this release. For CMS procedures and window descriptions, refer to the online help.
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